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Introduction
Welcome to MallinCam Control
MallinCam Control is designed to be a powerful, yet user friendly tool for viewing live images and recording
still pictures and video from your MallinCam Astronomical Video CCD Camera. It provides complete camera
control, allowing easy adjustment of all camera settings via a serial interface and provides a live video preview
when combined with the appropriate video digitizing hardware.

The software is available for both macOS and Windows and looks and feels consistent across platforms.
MallinCam Control is compatible with all versions of MallinCam cameras capable of being computer
controlled, and includes limited functionality for non computer controllable MallinCams (MC Jr., etc.) as well
as generic astronomical video cameras. For camera control it requires the use of a standard USB to Serial
port adapter (or a built in serial port), and a compatible video capture device.
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System Requirements
Operating System
• macOS 10.7 or later
• Windows Vista (32-bit or 64-bit versions)
• Windows 7/8/10 (32 bit or 64 bit versions, Windows XP is no longer supported)

Minimum Hardware (Macintosh)
• Any Intel® based Macintosh (PPC Macintosh is not supported)
• Memory: 1GB RAM; 2GB or more recommended
• Minimum free drive space: 20MB
• XGA (1024x768) or higher-resolution monitor
• USB serial port adapter
• Mac compatible video digitizer (see our Hardware Guide webpage)

Minimum Hardware (Windows)
• Intel® or AMD x86 processor running at 1.5GHz or higher
• Memory: 1GB RAM; 2GB or more recommended
• Minimum free drive space: 25MB
• XGA (1024x768) or higher-resolution monitor
• Built in serial port or USB serial port adapter
• Windows compatible video digitizer (see our Hardware Guide webpage)
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Installation
MacOS
MallinCam Control for macOS is distributed as a standard disk image (.dmg) file. By default, the file will be
downloaded to your “Downloads” folder, but it may be placed in another location if you have modified your
browser settings.

To install, simply double click to mount the disk image (this might have been done for you automatically after
it finished downloading). Drag the “MallinCam Control” application directly across to the the “Applications”
folder alias and it will be placed in the Applications folder on your hard drive. Once there, it can be dragged
to the Dock for easy access. The “MallinCam Settings” folder, and User’s Guide file should be copied to a
convenient place on your hard drive. Your “Documents” folder is a good place.
Windows
After downloading the MallinCam Control setup program, double click the icon and follow the on screen
instructions.
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You can specify the folders where application files will be placed, as well as the name of the program
manager group (Start menu folder). Decide if you would like to add shortcuts to the application in the Start
menu, Quick Launch bar, or on the Windows desktop.
When the installer is finished, double-clicking the MallinCam Control icon will launch the application for the
first time.

Registering Your Software
Before it is registered, MallinCam Control will operate in a time limited “demo” mode. It will display an
“Unregistered” watermark over your live video feed and will stop communicating with your MallinCam after 30
minutes of operation. To remove these limitations, you can purchase a license on the MiloSlick website.
Once your purchase has been processed (usually in less than one hour), you will receive an automated email
with your personalized Registration Code which can be used to unlock the software. If you do not receive the
email in a timely manner, please check your junk mail folder before contacting our support team.
Click on the "Help > Register MallinCam Control..." (Windows) or “Apple > Register MallinCam
Control...” (MacOS) menu item and enter the User Name and Registration Code from your confirmation

email. Make sure to type these values exactly as they appears in the email, including any punctuation and
upper/lower case characters. We suggest that you copy and paste the values directly into the respective
fields. When all the fields have been entered, click "Register" and your program will be fully enabled. You will
NOT need to reinstall or relaunch the software to gain full functionality. Remember that your MallinCam
Control license entitles you to free upgrades to any 3.x release of the software, and includes unlimited email
help and support.
Upgrading from Older Versions
If you own a license to an older version of the MallinCam Control software, enter your old registration
information in the appropriate fields. The program will recognize your registration code and the “Buy Now…”
button will change to “Upgrade…” and allows you to purchase a new license at a 50% discount off the
normal price.
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Getting Started
Connecting Your MallinCam
Using the software to adjust camera settings and view live images from your MallinCam astronomical video
CCD camera requires two separate cable connections between your computer and camera. Control of
exposure, white balance, cooling, and other camera settings is accomplished over a serial communications
interface (gray cable). The image comes from the camera in an analog video format, via either the composite
(BNC connector) or S-video port (black cable), and requires a separate video capture device (video digitizer)
connected to or built into your computer in order to convert the analog video signal into a digital one that
your computer can process and display.

A typical setup: MacBook Air, MCHP, Keyspan serial adapter, Diamond Micro USB video digitizer and cables.
(you hopefully won’t be using it with a 50 year old telescope)

Each of these connections is typically accomplished by the use of separate USB adapters, a USB-Serial
adapter for camera communications, and a USB video capture device to process and display video images.
Some (primarily desktop) computers include built in RS-232 serial (DB-9) ports which can be used without
the need for a USB adapter.
The two connections are entirely separate, and it may be possible for one to function correctly while the
other does not function at all, or only functions intermittently.
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Serial Communications
Control of your MallinCam requires the appropriate MallinCam control cable connected to either a built in
serial port on your computer or a USB to serial port adapter. Depending on the model of your MallinCam, it
may have one of two different types of serial interface. Cameras with a green power indicator LED have an
RS-485 serial interface, cameras with a red power indicator LED have the more common RS-232 serial
interface. Both are serial communications interfaces, but the hardware is incompatible. Make sure you
purchase the appropriate serial adapter for your model of MallinCam.

USB to serial adapters are available from a variety of sources and can be purchased with one or more serial
ports.These adapters typically require the installation of additional software and drivers usually supplied by
the device manufacturer. Most manufactures provide drivers for both MacOS and Windows, but be sure to
check for compatibility with your specific operating system before purchasing.
NOTE: On the Macintosh, we have had excellent results with adapters from Tripplite (formerly Keyspan),
IOGear, FTDI and TrendNet, since these manufactures provide up-to-date drivers compatible with most
versions of MacOS. Adapters which make use of the FTDI USB to Serial chipset are supported natively in
MacOS 10.9 and up and do not require additional drivers. In addition, many inexpensive no-name USBSerial adapters make use of the Prolific PL2303 chipset and there is an open source driver available here
(http://osx-pl2303.sourceforge.net) which may work with some of these devices. If you already own one of
these adapters without Macintosh specific drivers, this may be something to try before making an
additional purchase.

In addition to the standard single port adapter, multi port adapters are available and allow connecting
multiple serial devices (e.g. the MallinCam and the telescope mount) to a single USB port. This can be
important for laptop computers with limited numbers of USB ports.
When operating correctly, the information panel in the toolbar will display a status message in green, similar
to: MallinCam XTreme: Connected. If there are communications issues, a status will be displayed in red:
No MC Extreme found on COM3. In the case of communications problems, the user should first check
the camera options on the Camera Settings page to make sure that the correct options are selected.
Video Display and Capture
Unlike most astronomical still imaging cameras, the video image from your MallinCam is transmitted in
analog form via the composite (BNC) or S-Video port to your computer or standalone monitor. The S-Video
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signal separates the luminance (Y) from the chrominance (C) channels, resulting in a slightly higher quality
image compared to the composite signal, although real-world results are extremely dependent on cable
length and quality. The two video signals are usable simultaneously, and often users will connect one output
to a monitor mounted near the telescope, while the other is connected to their computer. Viewing the
MallinCam image on your computer requires a video capture device to convert the analog signal into a digital
signal that the computer can process and display.

Video capture devices are available from a number of different manufacturers, and compatibility and image
quality can vary wildly.Although most video capture devices connect to your computer via USB, internal PCI
card and (on the Macintosh) Firewire (IEEE-1394) converters are available as well.
When considering the purchase of a capture device, here are some things to keep in mind:
• Be certain that a driver for the device is available for your operating system. Occasionally third party drivers can be
downloaded for free or purchased, even when the manufacturer does not provide them.
• Be sure to chose a device with a composite video input, s-video input or both.
• Even though the MallinCam uses a Sony CCD chip with 811x508 pixel resolution, output consists of a standard
definition (SD) analog video signal which contains 525 interlaced vertical scan lines (NTSC version), of which only 483
make up the visible raster (the rest are used for synchronization and vertical retrace). Most video capture devices will
digitize this at a standard 4:3 aspect ration of 640x480, but some devices will offer 720x480 with minor distortion.
• High Definition (HD) capture devices may work if they have the required Standard Definition (SD) inputs, but remember
that you will be using the standard definition (either the composite or S-Video) input on these devices and nothing can
produce a higher resolution image when none exists in the source. Buy a high quality standard definition device with
comprehensive support on multiple operating systems and you will not be disappointed.
• Firewire converter devices that provide a standard firewire DV (Digital Video) output and can be used on the Macintosh
without any type of driver, although newer Macintosh without built in firewire ports may computers require a lightning to
Firewire adapter. Because these devices employ lossless compression, they can produce images free from artifacts
often inherent in USB digitizers.
• Most (but not all) USB video digitizers are “bus powered”, Firewire-DV converters are not, and require a separate
power brick complicating their setup.
• Not all digitizers support all analog video settings adjustments provided in the software. We are working diligently to
make these features compatible with more devices all the time.
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MallinCam Control Setup Wizard
When installed and run for the first time, MallinCam Control provides a simplified “Setup Wizard” to help first
time users with selecting the appropriate camera type, sensor options, serial port and video digitizer device

settings. The wizard provides a step-by-step process for choosing the basic settings to allow for camera
control and live video images. All options in the Setup Wizard can also be modified from within the
application itself.
The Camera Type setting should match the model of camera that you are using with the software. It is
impossible for the computer to distinguish between the various MallinCam models, and some of the settings
are unique to individual types.

The Sensor Type setting is mostly for informational purposes, but it will determine what type of test pattern
can be displayed (black/white or color bars) depending on if you have a B/W or color camera.
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The camera’s Video Format is used to calculate the SenseUp exposure duration based on the native frame
rate of your camera. You must set the video digitizer format (in the next step) to match.
The program will list all available Serial Ports in the pop-up menu. On a Windows machine, when you plug
in the adapter, the operating system assigns it a "COM" (communications) port number. For historical
reasons, this usually starts at port #3 (COM3) and counts up from there as additional devices are added. On
the Macintosh, these ports generally are listed by the name designated in the device driver. When setting the
serial port be careful to select the appropriate one.If you are experiencing problems connecting to your
camera, the software offers an option to log all serial communications. This is discussed more fully in the
“Preferences” dialog help page.

The Video Device popup menu lists all video capture devices attached to your computer. If your device
does not appear in the list, make sure that the driver is installed correctly. Occasionally the device name - as
returned by the device driver - may be a bit confusing. For example, the MallinCam MCV-1 video digitizer
often shows up as "USB 2828x Device" since it is based on the Empia Technologies 28285 chipset.
Some video digitizers have more than one Video Input connector, or channel. For example, the MCV-1 has
composite, S-Video and component video inputs. Chose which input you will be using to connect to your
MallinCam. If your digitizing device only has one connection, leave this as “default".
The Video Format setting is specific to the country where the camera is to be used. North America and
Japan use the NTSC video standard while much of the rest of the world uses some variation on the PAL
standard. The video digitizing format must match the video format of your camera.
The Video Size setting determines the resolution that the video capture device will digitize the signal. For an
NTSC camera, the MallinCam outputs a standard definition analog video signal which contains 525
interlaced vertical scan lines, of which only 483 make up the visible raster. Most video capture devices will
digitize this at an NTSC standard 4:3 aspect ratio, usually 640x480. Some devices will also digitize at
720x480, but since this resolution has a 4.5:3 aspect ratio, the resulting image will be slightly distorted.
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Once you have selected all the basic settings, click “Finish”, the setup wizard will close and the application
will automatically (re)open the main window. The software will remember all the selected settings and attempt
to automatically reload them upon launch.

Main Window

3

4
5

1
2

Parts of the Main Window
The main MallinCam control window is broken up into four main areas:
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1. Video Preview Area

The video preview area shows a live display of the image being captured by your video digitizing card or
device. Changes made to the image will display here. The user can overlay various graphics and text
information directly on top of the real-time image. Resizing the main window (see below) will cause the video
preview area to resize, letter or pillar boxing accordingly, to maintain the source’s aspect ratio.
2. Settings Page

To the left side of the main window is the “Settings” area which is where you can adjust exposure and other
settings on your MallinCam, modify video settings on your digitizing device, or set other live video effects
such as hot pixel removal or frame stacking. At the top of the Settings area is a selector which allows the
user to select from three different settings pages: “Camera” settings allow controls of the MallinCam, “Video”
settings control the video digitizing device and “Image” settings provide additional software based video
enhancements.
Controls are grouped into named “Control Groups” that can be expanded or contracted using the disclosure
arrow on the left side of the header bar. Some groups can be activated using a checkbox, or the settings can
be reset by clicking the “reset” button, both visible on the right side of the header bar.
3. Main Toolbar

The toolbar is where you will find buttons to do things like selecting the capture mode, taking snapshots,
choosing which layer settings should be visible, etc.
4. Information Panel

Centered in the toolbar is the “Information Panel”. This area gives real-time information about exposure or
integration, shutter mode, recording state, stacking settings, and camera status. This area also contains the
button to start and stop the “Hyper Mode” integration.
5. “Layer Settings” Header Bar

This contains the digital zoom, rotate, and flip controls which which allows the user to adjust the
magnification, orientation and angle of the displayed image – in real-time. These adjustments are done
entirely in software on your computer. The “Reset” button will cause all video effects to revert back to their
default values.
The main window can be resized by clicking and dragging it from any edge. The minimum size for the main
window is approximately 950x630px, which corresponds to a preview area of 640x480px.

First Light
Connect your camera to your computer using the appropriate cables and USB adapters as detailed in
“Connecting Your MallinCam”. Once your computer is communicating with your MallinCam and displaying
live video, you will want to try your hand at using your camera to image astronomical objects through your
telescope. Getting your first, properly exposed and focussed images can often be a challenging experience,
requiring patience as well as trial and error. Though - with practice - you will quickly learn to use your camera
to its full potential, capturing some beautiful images in the process.
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Basic MallinCam Operations
The MallinCam is an high precision scientific analog video camera specially designed and suited to image
everything from the sun, moon and planets, to faint astronomical objects. Because it outputs standard
analog video, the image is sent from the camera to an analog monitor, or your video digitizer, at the standard
video rate (25 or 30 frames per second), regardless of the length of the exposure. What this means is that for
any given exposure, the image will update continuously at the selected exposure interval. This is unlike most
single shot CCD cameras where the user opens and closes a shutter to start and stop the exposure and only
one image is produced. The distinct advantage of the MallinCam is it’s unequaled sensitivity and exposure
range, allowing real-time viewing of faint objects with exposures of only seconds. The think to keep in mind
however is that once the camera is powered on, it will start exposing and sending out live images on both
video output ports continuously. Changes to the camera settings occur just a quickly as you adjust them in
the software, and the user will be able to notice changes to the image immediatly, or at least within a single
exposure interval.
Exposure Settings
A rule of thumb for imaging deep sky objects is that the larger the telescope aperture and shorter the focal
length (lower focal ratio) the better. Although in general this is true, the MallinCam allows real time views of
faint targets with moderate sized amateur telescopes that are impossible to obtain otherwise.
Even in large telescopes, deep sky objects generally require exposures in excess of the 2.1 seconds which is
achievable in “SenseUp” exposure mode. The MallinCam employs a special “Hyper” exposure mode which
achieves exposures from 3 seconds up to several minutes depending on your model of camera.
To image DSO’s, switch the camera into “Hyper Mode” exposure by selecting the appropriate setting in the
exposure mode popup. For the MallinCam XTreme and it’s , the extended exposure time can be adjusted in
software from 3 to 540 seconds using the exposure slider. On the MallinCam Hyper/Hyper Plus and VSS,
Hyper Mode exposures need to be set using either the side mounted rate adjustment knob (VSS) or with the
switch settings on the MCHP. In this case, after changing the exposure on the camera, make sure to adjust
the exposure slider accordingly so that the software can maintain synchronization while processing images.
Once you have selected the desired exposure, clicking the “Shutter” button will start the Integration timer and
(in the case of the MallinCam XTreme and VSS) will send the command to start the camera integrating. Once
the integration in complete, the software will display the image from the camera and a new exposure will
start.
NOTE: On the MallinCam XTreme and VSS/VSS+, while the “Shutter” button is not depressed, the camera
will display images taken at the nominal X128 Sense Up exposure rate (2.13 seconds NTSC, or 2.56
seconds PAL).

The exposure time can be changed at any time, whether the camera is currently integrating or not.
Imaging the sun, moon, and planets can be accomplished with even moderate sized instrumentation.
Because of their small angular diameters, viewing details in planetary images requires high magnification
often achieved with the addition of a barlow focal extender. For full disk solar and/or lunar imaging, a focal
reducer or short focal length telescope is needed.

"12

MallinCam Control User’s Guide

Software Version 3.x

In “Video Mode” the live preview is updated at the standard rate of 30 frames per second (FPS) which allows
for easier focussing and adjustment of the object’s position in the frame. Keeping the automatic gain control
(AGC) off allows for fine control of exposure using nothing more than the Shutter Speed slider.
For some objects even the longest shutter speed (1/30th of a second) is not enough to produce a fully
exposed image. If this is the case, selecting “SenseUp” exposure mode allows extending the exposure
duration to just over 2 seconds.
MallinCam Settings Files
Your MallinCam can be used to view all kinds of astronomical objects from solar and lunar imaging to
capturing faint deep sky objects (DSO’s). The MallinCam Control software includes a number of basic
settings files which can be used to adjust your camera for various types of imaging. From the “File” menu,
chose the “Open Settings...” menu item and open the desired file installed with the software. These files can
be found in the “MallinCam Settings” folder which was, by default, placed in your “My Documents” folder in
Windows or wherever you placed it on your hard drive in MacOS. Because of differences in telescope size,
focal ratio and optical configurations, these settings should only be used as a starting point. Fine tuning of
exposure settings is covered in detail in the “Camera Settings” section. Once you have customized these
settings to you individual equipment, changes can be saved back out to new files, or these existing settings
files can be overwritten.

Basic Video Eﬀects
Zooming, Rotating, Flipping and Scrolling the Live Video
The video effects header bar just above the preview area contains controls that can be used to digitally zoom
(100% - 300% magnification), rotate (-180° to 180°) and flip (horizontally and vertically) the live video image
on your computer monitor in real time.

These image manipulations are done entirely in software, not on the camera, thus adjustments can be made
at any time and the results are instantly visible in the preview area. When the video image has been zoomed
and/or rotated so that it no longer completely fits in the preview area, the image can be scrolled so that
hidden parts of the image can be brought into view.
When the mouse is moved over the preview area the cursor will change to a “hand”. Clicking and dragging
the image will allow the portion which is outside the preview area to come into view.
Clicking on the “Reset” button will quickly reset the settings to their default values.
Pausing the Live Video
Normally the preview area will display a live video image from the MallinCam. Keep in mind that even though
the camera is capable of very long exposures, video output (via the composite BNC and S-Video
connectors) occurs at the standard rate of 30 FPS (NTSC) or 25 FPS (PAL), and the camera will simply
output a “saved” image between actual exposures. Because the software continues to display this “live”
image, it is possible to notice signal noise or loss of signal in real time.
"13

MallinCam Control User’s Guide

Software Version 3.x

To stop this live update to the preview window, select the “Video > Pause Video” menu item or press The
“Preview” toolbar button. This will cause the preview image to freeze and also send a command to the
camera to freeze the video image being output. The camera will continue to function normally, but the image
being displayed on the computer monitor or on a monitor connected to the secondary video output will not
update. Select “Video > Resume Video” (or press the “Preview” toolbar button again) to resume live viewing.
This feature can be useful when you want to move to a new object without getting the “trailed”

Taking Snapshots
Taking a snapshot of the current video preview contents and saving it as a still image to your hard drive is as
simple as clicking the “Capture” button in the main toolbar. The saved image will include any enhancements
that you have made using the video settings controls on your hardware capture device, stacking, dark frame
subtraction, or video effects. By default they will include any graphic or text overlays that you have enabled.
Images will be saved with the filename and to the location specified on the “Photos” settings tab of the
MallinCam Control preferences dialog.
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Camera Settings
Overview
The Camera Settings page is where all the adjustments that affect the MallinCam itself can be found.
Adjustment made here will directly affect the video signal from the camera and the effects will be displayed
on all video outputs (S-Video and BNC composite).

Camera Options
The Camera Options control panel is where you select which model of MallinCam you are using, the CCD
sensor type, video format, and which serial port the camera is connected to.

Since different models of MallinCam have different capabilities and methods of controlling the long “Hyper
Mode” exposure times, selecting the appropriate Model is critical. Keep in mind however that certain models
can be grouped together and treated as a single “family” of MallinCam (e.g. the XTreme and XTerminator
families).
The Sensor popup menu is mostly an informational section (i.e. it will not change the functionality of the
software), but it will determine if the built in camera test pattern is displayed as black/white or color bars. The
camera video output Format menu is used to calculate and display the appropriate “SenseUp” exposure
times, since NTSC and PAL cameras have slightly different video frame rates.
The Port menu is used to specify which serial port on your computer that the camera is connected to. Most
computers are no longer fitted with built in RS-232 serial ports and require USB to Serial adapters.
MallinCam control builds a list of all serial ports connected to your computer when it is launched. If you plug
in a USB-Serial adapter after MallinCam Control is running, it will not display in the drop down menu. Quit
and relaunch the application and your adapter should be listed. If not, check that you have the correct device
driver installed and working. On the Mac this can be determined by clicking “About This Mac” in the Apple
menu and clicking the “More Info...” button. In Windows, run “Device Manager” to determine if your serial
port is functioning correctly.
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Exposure
The MallinCam astronomical video CCD camera is capable of exposures from 1/12000th sec to several
minutes, but in order to achieve this range there are three distinct modes of operation which are described
below.
NOTE: Switching between exposure modes is accomplished by simply choosing a mode with the popup
menu. The software will automatically takes care of adjusting all the required camera settings for the
desired exposure mode.

Video Mode (1/12,000th to 1/60th sec)
This is the classic video camera modes of operation and is typically used for terrestrial, planetary, lunar and
solar observing. In this mode, the camera acquires images at the standard video frame rate of either 30 FPS
(NTSC) or 24 FPS (PAL) and exposure is adjusted by setting shutter speed.

The user can use the slider to adjust the camera’s shutter from “Off” (1/30th of a second) all the way down to
1/12,000th of a second. Keep in mind that the MallinCam has an electronic rather than a mechanical shutter
like many still imaging cameras.
Sense Up Mode: X2 - X128 (33ms to 2.13sec)
SenseUp (sometimes called DSS - Digital Slow Shutter) Mode is a video technology which allows extra light
to be collected by the imaging sensor with a marked increase in low light level sensitivity. The Sense Up value
indicates the number of video fields which are integrated before a new frame is placed into the video buffer
and appears on the external monitor.

In a standard video camera there are two interlaced video fields per frame, collected at 60 Hz (approximately
16ms - NTSC) or at 50 Hz (approximately 21ms - PAL) intervals. By adjusting the Sense Up multiplier, the
user can cause a greater number of fields to be collected, extending the shutter from X2 (33ms NTSC or
41.6ms PAL) out to X128 (2.13s NTSC or 2.56s PAL).
An important thing to remember about SenseUp mode is that the camera still outputs frames at the standard
PAL or NTSC rate, but the image that is displayed on the monitor will update less frequently. This can result
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in an image which appears “jerky” when centering or focussing, depending on the value of the SenseUp
multiplier.
Hyper Mode (3sec to 540sec)
The MallinCam includes a unique “Hyper Mode” method of increasing the exposure well beyond what is
possible with typical DSS or “SenseUp” cameras. This mode makes use of the custom “Hyper” circuitry and
extends the exposure range from: 3 seconds out to 540s (9 minutes) on the MallinCam XTreme; 3 to 112
seconds on the VSS/VSS+; and either 7, 14, 28 or 56 seconds on the MallinCam MCHP.

When “Hyper Mode” is activated, the MallinCam’s integration buffer is reset and can take up to 3 minutes to
build up a fully integrated image. During this time a countdown timer will display in the status area and you
will be unable to initiate the integration sequence. Once the timer has counted down to zero, you can click
the “Start Integration” button to begin the first exposure.
Setting Hyper Mode exposure times varies depending on your model of MallinCam.
• MallinCam Hyper and HyperPlus (Color or B/W) – The MallinCam Hyper has two long exposure modes - 7 seconds
and 14 seconds, activated by the use of switches on the side of the camera. The MallinCam HyperPlus adds two
additional exposure settings (28 and 56 seconds). Unfortunately there is no way for the the MallinCam Control
software to determine the current hyper mode exposure switch settings, and requires the user to adjust the slider
when the switch positions are modified. Doing so insures that saving of image sequences and frame stacking/
averaging will be synchronized with the long “hyper” exposure settings.
• MallinCam VSS and VSS+ – Adjusting Hyper Mode exposure settings on a MallinCam VSS (or VSS+) is accomplished
with a side mounted knob, rather than switches like on the MCHP. This allows totally variable exposures between 3
seconds and either 56 seconds or 112 seconds depending on the setting of the “X2” checkbox which causes the built
in electronics to double the exposure time set on the control knob. Just like with the MCHP, you should always adjust
the HyperMode slider to match the exposure time set on the Rate knob.
• MallinCam XTreme – Hyper Mode exposure settings on the MallinCam XTreme are entirely dependent on either
computer control or the wireless shutter controller. One distinct advantage of this is that exposure times are infinitely
variable and when computer controlled, collected images are perfectly synchronized with the exposure time.Use the
slider to select the desired integration time which is adjustable in 1 second increments from 3 to 240 seconds. To
begin an exposure, click the “Shutter” button below the video preview and the camera will begin integrating. When the
full integration is complete, the captured image will be displayed and a new exposure will begin automatically.The
exposure time can be adjusted at any time. If an integration is currently in progress, the new exposure time will begin
when the current exposure finishes.
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NOTE: While the “Shutter” button is not depressed, the MallinCam XTreme and VSS cameras will display
images taken at the nominal X128 Sense Up setting (2.13 seconds NTSC, or 2.56 seconds PAL).

Automatic Gain Control (AGC)
The AGC setting controls the final CCD amplifier gain on the MallinCam. It functions in all exposure modes
and is one of the most important settings for controlling image appearance. For lunar and planetary
observing, the recommended setting is to turn ACG “Off” and rely on the shutter speed setting to control
exposure. Since the onboard op-amp amplifies sensor and electronic noise as well as image data, it is (in

general) best to use as low a setting as possible to obtain the desired result. A general rule of thumb is to
start with AGC at around 3 or 4 and adjust as necessary.
NOTE: In Hyper integration mode, whenever the AGC setting is changed, the integration buﬀer is
automatically reset and the countdown timer will begin anew.

The AGC slider is disabled while actively integrating in “Hyper Mode”. To change the AGC setting while
exposing images in HyperMode, click the “Shutter” button to stop the current exposure, change the value,
wait for the countdown timer, and start a new exposure.

White Balance
White Balance is a means of assuring that objects that are white actually appear white in your image. This
option is only available on color capable cameras.

There are five options available:
1.

ATW (Auto Trace White-balance): Recommended for most DSO observing

2.

AWC (Auto White-balance Control): Direct the camera toward a white object and press the “Set” button.

3.

3200°K (“Indoor” setting, fixes the color temperature to Tungsten lighting)

4.

5600°K (“Outdoor” setting, fixes the color temperature to Daylight)

5.

Manual: This should be used when observing under urban, light polluted skies. Recommended settings are Red: 2
and Blue: 5, but these can be adjusted to achieve the best image.
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Camera Gamma
This controls the output Gamma setting of the MallinCam’s video processor. Selecting the gamma setting of
0.45 will show the most detail but will also result in a slightly brighter background. A gamma setting of 1.0

will result in a slightly darker image and is best for use with an LCD monitor or a video digitizing device. The
gamma setting affects the output of both the composite and S-Video outputs.

Advanced Pixel Control (APC)
APC is used to control on board horizontal and vertical image processing done by the MallinCam. The user
can adjust both horizontal and vertical levels to provide the best output image. The default setting in both

dimensions is 8 and generally, when imaging deep sky objects (DSO’s) the values should be set to their
minimum to reduce the appearance of warm and hot pixels on the sensor.
Higher settings can be used to bring out details in lunar or planetary images but will often result in star
images with dark centers or “halos”. For most DSO observing, low to medium values are recommended.

Coronagraph (Highlight)
Highlight is used to artificially darken bright areas on the video image. When viewing the sun through a
Hydrogen Alpha filter, the “Highlight (Coronagraph)” slider can be used to effectively block out the bright

surface of the sun allowing the solar prominences to be seen more easily.
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Video Crosshairs (Mask)
The MallinCam has the capability to display up to 4 independent rectangular “mask” areas which can be
used to obscure areas of the video image with translucent gray boxes. By carefully placing them as thin
rectangles, they can be made to appear as “crosshairs” which, since they are generated in the video circuitry

of the camera itself, are displayed as part of the video signal and can be seen on the digitized image as well
as any analog video monitor connected to your camera. The software can display these “pseudo crosshairs”
in a number of styles. Since these are superimposed on the analog video signal, the software provides a
mechanism (X and Y position adjustments) to center the crosshairs on the video image.

Camera Output

The Camera Output options can be used to modify the video output signal from your camera. The Color
Bars (or Grey Scale Bars) screen can help calibrate your monitor or image capture device.
Flip Horizontal and Flip Vertical are used to adjust the video image to match an objects true orientation. The
is commonly used for lunar, solar and planetary viewing.
The Zoom checkbox will activate the camera’s built in electronic zoom function. The amount of zoom can be
adjusted between 1x and 2x. NOTE: Because zooming occurs in steps within the camera, if the MallinCam is
set to a long exposure mode (Sense Up or Hyper Mode), it will take several image refreshes (one for each
step) to arrive at the final zoom value and the camera will be unresponsive until the new zoom setting has
been achieved. For this reason, camera output changes are disabled while the camera is actively integrating
in “Hyper Mode”.
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Unlike similar settings in the Video Effects header bar, these options affect the video output of the camera
itself and can be seen on a monitor connected to the secondary video connector as well as the preview
pane.

Peltier Cooler (TEC)
On the MallinCam VSS, XTreme (and it’s relatives), the mild peltier thermo-electric cooler built into the
MallinCam is designed to cool the CCD sensor in one of two modes: “Automatic” (0 through 8) and
“On” (Continuous).

• Automatic (0 - 8): In “Automatic” mode, each frame is analyzed for noise and, if detected, the Peltier cooler is turned
on for a fixed amount of time during the next frame. The slider adjusts the degree of cooling which is performed, with 0
being the minimum, and 8 being the maximum automatic setting.
• On: When set to “On”, The TEC will operate in a 100% duty cycle mode. This is the preferred setting for the longer
integration times needed for observing DSOs. The disadvantage of running the Peltier cooler continuously is that
condensation can form on the front surface of the CCD causing stars to appear blurry.

On the MallinCam XTerminator family of cameras, the peltier cooler set points have been greatly simplified
and behave very differently. There are just two “Setpoints” (-5°C and -25°C) which cool the CCD chip to 5
and 25 degrees centigrade below zero respectively. The “Off” setting still runs the cooler a minimal amount of
time.
NOTE: The Peltier Cooler adjustment only functions on the MallinCam XTerminator, XTreme and VSS
cameras. The MallinCam Jr. Pro has no built in cooling, and the MallinCam HyperPlus uses a toggle switch
on the side of the camera to turn the cooler on and oﬀ. There is no way to completely turn the TEC oﬀ on a
VSS or XTreme, but setting the cooling level to 0 will result in the least amount of cooling.
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Video Settings
Overview
Settings on this page affect the Video Digitizer adapter and will not change the image of an analog monitor
connected directly to the MallinCam itself. Not all video digitizers allow for all the adjustments shown in this
section, if an adjustment is grayed out, or does not appear to make a noticeable difference in the live image,
it is likely that your digitizer does not fully support that particular setting adjustment.

Video Device Options
After connecting your capture device and installing the appropriate driver (if needed), the device should
appear in the Device popup menu. If you do not see it listed, try selecting the “Rescan...” menu item. This

will force MallinCam Control to search for any new devices. If no devices are available, the preview area will
display a “No Video Devices” message.
The Input menu provides a way of selecting between two or more input channels on your video digitizer (if
available). Typically adapters will provide both S-Video and composite video inputs, but if the device contains
only one, the menu will display “No Selectable Inputs”.
The Format setting is used to synchronize the digitizing frequency with the video signal and must match the
camera’s video output format (NTSC or PAL). This is determined by the type of camera you purchased and
can not be modified.
The Size setting determines the resolution that the output video signal is digitized at. Even though the
MallinCam uses a Sony CCD chip with 811x508 pixel resolution, output consists of a standard definition
analog video signal which contains 525 interlaced vertical scan lines (NTSC version), of which only 483 make
up the visible raster (the rest are used for synchronization and vertical retrace). Most video capture devices
will digitize this at a standard 4:3 aspect ration of 640x480, but some devices will offer 720x480px, but the
image will be distorted (stretched) horizontally. PAL cameras offer slightly higher vertical resolution (576 visible
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lines - at a slightly lower frame rate) and the horizontal resolution is 720 pixels to maintain the standard 4:3
aspect ratio.

Video Settings
The Video Digitizer Settings page is where the user can control signal levels and other options on their
capture device. Settings made here are applied on the video capture device and will only be visible in the
preview area, not on a monitor connected to the secondary video output of your MallinCam.

These adjustments all modify settings on your hardware video capture device (MCV-1, Canopus, Dazzle,
etc.). Keep in mind that not all settings will function with all devices. This is entirely dependent on the device
and/or the support built into it’s driver (if any).
Since each video capture device is different, values are adjusted and displayed as a percentage of their
maximum rather than their absolute value. Adjustments take place in real-time as the user moves the slider
with the mouse. Clicking in the bar on either side of the slider handle will cause the setting to jump in
increments 10%. Fine adjustments can be made by clicking the up/down button to the right of the slider.
Clicking the Reset button will cause the values to revert to their default positions (which are device
dependent).
NOTE: Remember that adjustments to these settings cause significant changes to the displayed image and
will require substantial changes to the other video filters. It is recommended that you make adjustments
here before enabling and fine tuning any of the other video filter settings. Video Setting adjustments are
disabled when Frame Stacking is enabled.

Video Stacking
The Video Stacking menu can be used to help reduce the effects of noise introduced by the hardware
compression used in most video digitizing devices. Smoothing is performed entirely in software and can
dramatically improve the live images, though CPU requirements tend to be high. This option is only active
when the corresponding checkbox is checked.
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This is different than “Frame Stacking” which is used to average individual image frames and employs a
significantly more complex stacking algorithm. Although not necessary, the two can be used and selected
simultaneously.

Limit Video Frame Rate
In normal operation, your video digitizing device will collect and process frames as quickly as possible. The
actual frame rate will depend on your digitizer, the speed of your computer and the bandwidth of the USB
port that it is connected to. When enabled, this option can be used to limit the frame rate to a value below
the maximum rate possible with your hardware configuration. This can be used to limit the CPU usage

needed by the MallinCam Control software, or to match the effective frame rate of a generic video camera
when it is being used in a long exposure (DSS - Digital Slow Shutter or SenseUp) mode.
The Presets menu contains common values for most NTSC based DSS generic astronomical video
cameras. Although the software will not control non-MallinCam brand cameras, by choosing a frame rate
that matches the DSS/SenseUp setting of your video camera, the frame digitizing rate can be made
synchronous with the camera’s frame update rate, allowing most of the post-processing image
manipulations (frame stacking, etc.) to be performed correctly.
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Image Settings
Overview
Image Settings control the final displayed image in the preview area. All these adjustments take place in realtime on the computer and will not be reflected in the image of an analog monitor connected to the secondary
video port of the MallinCam. Except for the Histogram, (which is calculated last) the the output of each
enabled filter feeds into the one listed directly below it, thus the raw digitized image feeds into the Hot Pixel
Removal tool, which then is processed and sent to the Dark Frame Subtraction tool, then Stacked,
smoothed, sharpened and processed by each of the miscellaneous filters. The final processed image is then
adjusted by the Histogram and displayed in the preview area. Although the Histogram is processed last, this
filter is the one which is adjusted most frequently, and thus occupies a special place in the application
window - always visible at the top of the settings panel - irrespective of which page (Camera, Video, or
Image) is selected. Because of the Histogram’s importance, we will start our discussion there.

Histogram
The Histogram tool can be used to improve the appearance of nebulae, galaxies, etc. by applying level or
curve adjustments to the combined Intensity (Y) channel, or to each color channel (R/G/B) individually. The
graph displays the selected channel brightness values (generally 0 to 255 counts for standard 8-bit video
digitizers) vs a normalized representation of the number of pixels in the image that correspond to that value.
The left side of the X-axis at 0 represents black, whereas the right edge is white, at 255 counts.
In the example below, most of the pixels in the image of M51 are relatively dark in appearance, (between 0
and approximately 48 counts), and the numbers of pixels brighter than 48 counts quickly taper off as the
brightness increases. This graph will be the starting point for a discussion on how the histogram filter can be
used to modify the image using either “Levels” or “Curves” adjustments..
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Levels
The three “level” values specify both the lower (black point) and upper (white point) brightness limits of the
image, as well as the midrange (gamma) value. When enabled, image data above and below the minimum
and maximum levels are discarded. Changing the black and white points stretches and converts the image
brightness from the selected values to a full 0 to 255 counts..

In the graph above, sky background below 34 counts will be discarded and converted to 0 counts (full black)
in the processed image. Image data above 200 counts is similarly discarded and the processed image is
“stretched” so that 200 counts of brightness is redrawn as full white (255 counts). The effects of these levels
settings can be seen in the two images of M17, the “Swan Nebula” shown below.

M17, Swan Nebula: Before (left) and after (right) Histogram levels adjustment.

The midpoint (gamma) slider can be used to tease out details in the original image that are difficult to see
normally. Moving it to the left will brighten the overall appearance, and likewise moving the slide to the right
will cause the overall image to take on a darker appearance. Changes to these adjustments should be made
gradually, in small increments. Excessive adjustments to either setting can result in an overly contrasty, and
grainy image. All calculations are done using full 16-bit numeric resolution, resulting in incredibly smooth and
detailed results.
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Curves
Like Levels, curves can be used in enhance and bring out details in the original image that are difficult to spot
without any adjustments. The major difference between the two methods is that curves gives four points of
adjustment rather than the three afforded by levels.

Black point and white point values behave similarly to the corresponding levels settings, but in the case of
curves, it is possible to specify both input and output values that are non-zero, or non-full-range. Unlike
Levels, curves specify a specific 8-bit output value for each of the 255 input brightness intervals. This results
in an essentially 8-bit transformation, but the ability to specify four inflection-points on a spline curve defining
input to corresponding output brightness values (black point, white point and two mid points), can often
result in more detail.
As inflection points are moved, their input and output values are shown below the graph. The four tie-points
define fixed input and output values along the curve, and all other relationships are calculated from these.
The resulting input/output values are displayed as the curved line connecting the inflection points.
Channel Selection (Y or R, G, B)
Most of the time histogram adjustments should be made uniformly to all three image channels (R,G and B)
simultaneously. When the Y (Intensity) channel is selected, the graph shows an average of all three channels
as a translucent gray representation of the intensity distribution. When any of the other three channels is
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selected, the graph changes to show the selected channel’s pixel distribution separately, overlaying the other
two channels.

Adjustments made to levels or curves while a single channel is selected only affect that channel, leaving the
others untouched. This can come in handy when the object being viewed is dominated by a specific color
channel, or one o the other color channels is particularly under represented. In these cases, adjusting
individual color channels can help to bring the image into a more natural white balance.

Hot Pixel Removal
“Hot Pixels” are individual pixels on the CCD chip which have a higher than normal rate of charge
accumulation. They appear as bright points of light in long exposures. The Hot Pixel Removal tool will
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intelligently replace hot pixels with an average of the image data immediately surrounding them. In this way,
hot pixels can be removed from an image without causing the “black holes” which are a common problem
when simply subtracting a “dark frame” from the image.
The user can define as many hot pixels as they would like. Hot pixels are specified by their (x,y) coordinates
(on the digitized image, not on the CCD sensor), their brightness (in A/D counts), and their size in pixels.
Using the Tool
Cap your telescope and set the Hyper Mode exposure to a reasonably long duration to show your sensor’s
most egregious hot pixels (5-20 seconds is usually plenty). The TEC (Peltier) cooler level should be set to a
value that you use for most of your observing. Cooling the sensor appropriately will assure that only “hot”
pixels (those which are *always* visible in your image) and not “warm” pixels (those which are thermally
generated) are being defined. After the camera has stabilized, you should have an image similar to the one
below.

MallinCam XTreme “Dark Frame” - 10s exposure, AGC: 3, maximum cooling

In this image we can easily see three bright hot pixels and four (or five) dimmer ones. We will first concentrate
on defining the brightest - white - hot pixels in the image.
Using the Auto Detect Feature
The “Detect” button can be used to automagically detect all the hot pixels in a dark frame image. Set your
exposure appropriately, and start the camera integrating while fully covered. Select a “Level” to be used for
hot pixel detection. Pixels darker that the selected value (as a % of the full brightness) will not be analyzed.
Clicking “Auto” will scan the image, and add each hot pixel that it finds to the list.
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If the tool did not detect all the hot pixels in the image, you can try lowering the auto-detection threshold
(level) and clicking the “Auto” button again. Duplicate entries will be ignored, and new ones will be added to
the end of the list. The auto-detect tool uses the same algorithm to determine the minimum size of the hot
pixels area (average surround is 80% darker than the centroid).
Adding and Removing Hot Pixels
Click the “Add” (+) button, and move the cursor over the dark frame image in the preview area. Carefully
center the crosshairs on the middle of the “hot pixel” and click the mouse button.

An entry will be made in the hot pixel list box, the entry will be “selected” and a small “target” will be
displayed over the hot pixel.
The tool will choose the smallest size which corresponds to an 80% drop in brightness from the user defined
center of the hot pixel. This size is the region of the image which will be replaced when the filter is enabled.
Define as many hot pixels as you find appropriate. If you make a mistake, select the entry in the list and click
the “Remove” (-) button to delete it.

Multiple entries can be selected simultaneously by clicking on them while holding down the Shift or Controls
(Option) keys. Selected hot pixels are shown in the preview area with the red “target” icon.
Once you have defined all your hot pixels, click the “Enable” checkbox and they should magically disappear
from your image!
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Same image, but with “Hot Pixel Removal” disabled (left) and enabled (right)
If you find that one or more of the hot pixels is not completely removed, increasing the size of the area to be
replaced will usually take care of the problem. Select one or more pixels in the list, click the “Size >” button
and choose the appropriate dimensions in the popup menu (from 1x1 pixel to 5x5 pixels).
Saving and Loading Hot Pixel (.HPX) Files
Since Hot Pixels are part of the CCD sensor itself, they are relatively stable over the lifetime of the camera.
The Hot Pixel Removal tool provides a way of saving a set of defined hot pixels to a file for use later. The
“Save” and “Load” buttons can be used to manage a set of hot pixel “map” files (extension .hpx) on your
hard drive. These files are stored in plain text format and can be edited in any plain text editor if needed.
Other Hot Pixel Removal tool considerations
Remember that the checkbox at the top of the Hot Pixel Removal control group needs to be checked to
enable the tool. Clicking and holding the quick-view (eyeball) button to the right of the Load… And Save…
buttons will temporarily highlight all the hot pixel locations. If a particularly bright hot pixel is not completely
removed, you can select it from the list and increase the “Size” parameter. This will cause a larger area to be
replaced, so it is recommended to keep the hot pixel sizes to a minimum. If you have forgotten to cover your
scope, or the auto-detection limit has been set to too low a value, the auto-detect feature will occasionally
find too many hot pixels in the image. If this is the case, make sure the scope if fully covered or increase the
detection limit (and/or reduce the integration time).

Dark Frame Subtraction
This feature will allow you to take a “Dark Frame” image and subtract it in real-time from all subsequent
incoming frames. When done correctly, dark frame subtraction can be used to to reduce the appearance of
amp glow, warm pixels and dark current noise often associated with long exposures. Once the dark frame
has been created, you can subtract it from all incoming video frames by checking the Enable checkbox.
This provides a way of instantly seeing the effects of this filter on the live video image.
Dark Frames vary with exposure time, and even from chip to chip so it is often recommended to create a
“library” of dark frame images specific to your camera at a variety of exposures (e.g. 30s, 60s, 90s, etc.).
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Creating Dark Frames
Since Dark Frame images are subtracted form the raw video image, they need to be processed in a way that
will eliminate artifacts like “black holes” where bright spots appear in the dark frame. This processing is done
automatically when you click the Create button, eliminating the need to go through multiple steps to create
a.usable dark frame image. The raw image will be converted to gray scale and smoothed to reduce the
effects of bright spots which can lead to errors in the dark frame subtracted image.
When you click the Create button, a message will remind you to cover your scope, the exposure will be
completed and the Dark Frame Information will up updated with the current exposure information.

Using Stored Dark Frames
The Load... and Save... buttons allow you to save to and load dark frames to disk as standard PNG images
(with no compression). When saving, the filename defaults to "Dark Frame" with the current integration time
appended in parentheses. Since hot pixels, amp glow and dark current change very little over the life of a
CCD sensor, this feature can be used to store a collection of dark frame images, taken with various lengths
of exposure, that can be loaded and used without having to go through the trouble of taking new ones each
observing session.
Adjusting the Dark Frame Level
The Subtract slider will adjust the scaling of the dark frame that is subtracted from the raw video (from 10%
to 200% of the original). This allows you to fine tune the subtracted dark frame to effectively remove most
artifacts without removing too much of the exposed image.
The Adjust automatically with exposure option will automatically adjust the dark frame level whenever the
integration time is changed. The software “remembers” the exposure time when a dark frame is captured or
loaded, and will adjust the scaling factor independently of the manual adjustment as the exposure is
changed, up or down. When this option is checked, the actual scaling factor is determined by the following
equation:

!
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Frame Stacking
Frame stacking is the process where N individual images are placed over top of each other and summed or
averaged, pixel for pixel, to create a new image that has greater dynamic range and a higher signal to noise
ratio than the originals. You can use this option to sum or average 2 to 10 video frames to dramatically
increase sensitivity or decrease image noise. Unlike post processing software like Lynkeos or Registax, this
processing is calculated and displayed in real-time in the MallinCam Control preview area.

When the MallinCam is operated in Video or SenseUp exposure modes, frames are captured by the video
digitizing device at the standard video frame rate (25 or 30 FPS) and stacking will occur at this native
frequency. In Hyper Mode, new frames are synchronized to the long exposure times and stacking/averaging
will occur after each exposure is completed.
Averaging vs. Summing
A “summed” stack will produce an image N times brighter than the individual images, whereas an “averaged”
stack will be approximately the same brightness as any one of the originals. Both methods will result in
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smoother, less noisy image because random noise generated in the digitizing process will be distributed
across the resultant image.
Rolling Average
A “Rolling Average” stack will average the more recent N exposures and a new image will be displayed in the
preview window with every new exposure. As the stack fills, the first image in the stack will be dropped and

2 Frame - Rolling Average - 20s Exp.

Frame 1
20s exp.

Initial Preview Update

Frame 2
20s exp.

Preview Update (20s later)

Frame 3
20s exp.

Preview Update (20s later)
Frame 4
20s exp.

the new image will be added to the end of the stack, assuring that there are always N frames to process.
The example below shows a simple 2 frame rolling stack, though it can easily be extended to include any
"34

MallinCam Control User’s Guide

Software Version 3.x

number of frames (up to 10). Just beware that even though the preview will update after every exposure, a
fully stacked image will not be displayed until a full N exposures have been taken.
Arithmetic Sum
An Arithmetic Sum behaves similarly to the Rolling Average stack, but instead of averaging N frames, the
resultant image will be a pixel by pixel sum of each of the frames. This type of stack is often used with
relatively short exposures, in conjunction with Frame Corrections (discussed in more detail below) when
longer exposures would result in smeared images because of drift across the field of view.
High Dynamic Range Average
High Dynamic Range (HDR) averaging consists of taking images at varying exposure times and combining
them into a single image retaining detail in both dark and bright regions. There are a number of HDR
techniques that have been developed over the years, but none are particularly suited for astronomical
imaging. Most employ tone-mapping to optimize contrast across an entire image, but because of the
intrinsically high contrast already associated with astronomical images, these techniques don’t work
particularly well. Here we implement a modified version of the Debevec algorithm [Debevec and Malik 1997]
which has been optimized for the relatively low dynamic range images inherent in digitized video.
Most HDR techniques employ a limited number of images, often just one underexposed, one overexposed
image as well as a correctly exposed image. In our algorithm we make use of up to 10 images - all taken at
increasingly longer and longer exposures, although there is often little more useful image information to be
found beyond 4 or 5 exposures.
A series of HDR exposure times is determined by taking an initial (base) exposure time and then calculating a
linear or exponential series of additional exposure times. The user starts by selecting an initial (minimum)
exposure time (using the “Exposure” slider on the Camera Settings page) and then choosing a method for
calculating exposure steps. The calculated series of exposure times is shown in the Frame Stacking control
panel Each time any of the parameters is modified (# of exposures, minimum exposure and/or exposure
step), the series is recalculated. As each subsequent exposure is taken, the exposure time will be
automatically adjusted to the next value in the sequence.
An HDR optimized image will be calculated after every new exposure is taken, but the best results are
obtained only after a full stack (at the selected settings) is complete. Once the full series of exposures has
been taken, the software will revert back to the minimum exposure and begin collecting another set,
discarding the oldest matching exposure.
Frame Corrections
Because Frame Stacking requires a minimum of N exposures for complete processing, image shift due to
misalignment or other errors can become an issue. To help alleviate these errors we have built in a method of
correcting the alignment of subsequent stacking frames by calculating an offset based upon the position of a
guide star within the field of view. The use can chose a (single) guide star by clicking the “Set…” button and
then pinpointing a suitably bright star in the image. The position of the guide star is determined for each
subsequent exposure, and the image is shifted vertically and horizontally (or both) to correct for the drift.
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For now only a single guide star is considered, and corrections are limited to only horizontal and vertical
offers (field rotation is not corrected). Improvements to these corrections will come in subsequent version of
the software.
Other Frame Stacking Considerations
Each time the user changes the number of exposures the stack is reset, requiring a full sequence of
exposures to calculate a fully stacked image. Additionally, when switching between objects, it is required to
reset the stack or else old images will be averaged in with new ones - which can lead to “interesting” results.
Lastly, there is an option to show the stacking frames (View > Show/Hide Stacking Frames) in an area on the
right side of the main window.

Sharpening and Smoothing
When selected, these filters provide a way of sharpening (using an unsharp mask algorithm) or smoothing
(with a gaussian blur) the image with user selectable radii and sigma (the standard deviation of the Laplacian),
both measured in pixels.

Miscellaneous
These filters can be used to modify and improve the preview image. All filters are performed in software and
can be enabled/disabled individually.
Grayscale
Converts the color image to grayscale using one of four techniques:
• Average: Y = 0.33R + 0.5G + 0.16B
• Weighted Avg: Y = 0.375R + 0.5G + 0.125B
• Photometric ITU-R: 0.2126R + 0.7152G + 0.0722B (double precision)
• Digital NTSC/PAL CCIR601: 0.299R + 0.587G + 0.0114B (double precision)

Invert Image
Inverts the color data on the image
Despeckle
Reduces speckle noise
Enhance
Uses a filter which attempts to minimize noise
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Layer Settings
Overview
After all adjustments are made, the resulting image layer is combined with three additional “overlay” layers, a
Graphic Overlay, Text Overlay, and a Drawing Overlay. Each of the four resulting layers can be adjusted

independently and, when saving images, the user has the option of including the overlay data or not (See:
Photo Preferences). Settings for each layer are adjusted by using tools in the header bar located at the top of
the Preview area, and toolsets are selected with the “Layer Settings” toolbar selector.

Video Frame Layer
The video frame layer contains the final processed image scaled to fill the preview area. The digitized frame
size is determined by the resolution (size) settings of your video digitizer (see: Video Device Options), and is
usually 640x480 pixels (for an NTSC video signal). This results in an image with a 4:3 aspect ratio which is
scaled and displayed letter boxed or pillar boxed depending on the aspect ration of your application window.

The image can be scaled (up to 300%), rotated (180° clockwise or counterclockwise), and flipped vertically
and/or horizontally, by using the buttons in the Video Frame toolbar. While the image is zoomed, you can
click and drag the layer around the preview area to reveal additional regions. The “Reset” button will return all
settings to their default values.
As you move the mouse over the preview image, its X and Y coordinates, as well as the pixel Red, Green
and Blue intensity values are displayed in the header bar. 24-bit video digitizers provide 8-bits of resolution in
each of the three channels, so values will range from black (RGB: 0, 0, 0) to full white (RGB: 255, 255, 255).

Graphic Overlay Layer
MallinCam Control allows you to chose from a number of standard crosshair, graduated or astrometric
reticles, and grids which can be scaled, rotated, and adjusted, over top of the live video image. All
adjustments can be made using the popup menus and buttons in the Graphic Overlay toolbar.
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Use the popup menu to choose from 16 different fullscreen and circular crosshairs, grids and other graphic
objects.

Some of the graphic overlays available in MallinCam Control

The overlay color is selectable by clicking on the color box, and transparency is adjustable from 0%
(completely transparent) to 100% (completely translucent). The rotation and size are adjustable using the
appropriate buttons. Like all the other layers, you can move the graphic overly around the screen by clicking
and dragging with the mouse.

Text Overlay Layer
The software will optionally overlay up to 5 lines of text, each of which is described below. The user can
select the size (10pt to 36pt- 0pt uses the system default size) and color (by clicking on the colored
rectangle) of the overlay, but all text overlays will be displayed with the same attributes.
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Time Stamp
This option places the date and time, formatted using your system settings, in the upper left corner of the
image.
Exposure Information
Shows the MallinCam exposure setting, and a running countdown of the current exposure.
Stacking Information
This will include the current and total number of frames in the stack.
Camera Information
Displays the model of camera as well as the type of sensor, as defined in the Camera Options control group
on the Camera settings page.
Text Comment
This can be used to add your own description or other information limited only by the amount of text which
can be displayed in a single line.

Drawing Overlay Layer

The drawing overlay layer can be used to add a simple sketch to the live video, allowing the user to highlight,
circle, or other wise post out various parts of the image. The pen and eraser toolbar buttons behave exactly
like you would expect, letting you hold the mouse button to draw or erase freehand lines in the selected
width, color and transparency.
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MallinCam Control Preferences
Click the “MallinCam Control > Preferences...” (MacOS) or “Edit > Preferences...” (Windows) menu item to
open the MallinCam Control Preferences dialog.

General Preferences

Miscellaneous
Feedback

Checking the Feedback checkbox will cause the software to play a soft tone at the end of each Hyper Mode
integration cycle. Because the MallinCam operates continuously while imaging, there is no indication from the
camera itself when the Hyper Mode exposure has completed and it has begun a new one. This option can
serve as an audible indicator for when you can not watch the exposure timer on your computer screen.
Serial Communications Logging

The communications logging option logs all input and output to either the “Console” application (in MacOS)
or to the Windows debug log.
On the Macintosh, “Console” can usually be found in the “Utilities” directory which is in the “Applications”
directory of your hard drive.

Copyright © 2012-2017, MiloSlick Scientific
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To see the log output in Windows, you'll need to download Microsoft's DebugView application from here:
http://technet.microsoft.com/en-us/sysinternals/bb896647.aspx
This program lets you look at debug logs generated by Windows, MallinCam Control and other software
installed on your machine. There is no installer, just place the executable in a convenient place on your hard
drive.
Software Update
When checked, MallinCam Control will automatically check for updates and alert you when they become
available. It is recommended that you leave this option checked to be assured that you always are running
the latest and best version of the software. If you would like to be informed when pre-release versions of
MallinCam Control are made available, uncheck the “Final releases only” checkbox.
When a new release is made available, a dialog box will appear and prompt you to download it to your
computer. After downloading, simply quit MallinCam Control and copy the new version to your “Applications”
folder (MacOS) or run the downloaded installer (Windows) to update your software.

Photo Preferences
Photo Files
Save Photos to:

Use the popup menu to chose a folder where photos should be saved. The menu contains some common
locations and includes an option to “Choose” a custom location. The location is automatically saved and will
be used each time you run MallinCam Control.
Filename:
• Ask: The software will display a “Save As...” dialog box each time a new snapshot is taken.
• Timestamp: The filename for the saved image will automatically be determined by your system time and will be in the
format - YYYYMMDD.HH.NN.SS.jpg.
• Sequential with Custom Prefix: This option can be used to save multiple images with the same file prefix (e.g.
“NGC891_” or “CrabNebula”) and a four digit value will be automatically appended and incremented as each photo is
saved. Remember to include some type of delimiter (the above example uses an underscore character) if your prefix
ends in a numerical digit to avoid confusion with the appended suffix. The current image sequence value is
automatically saved loaded each time you run MallinCam Control. Click the “Reset #” button to reset this value back to
zero (“0000”).

Photo Options
Feedback:

Specifies whether a shutter sound will be played when taking snapshots.
Overlays:

Select this option to include graphic and text overlays in the saved image files. Video overlays include the
reticle images, and text overlays. Unchecking this option will not remove the “Unregistered” watermark.

Copyright © 2012-2017, MiloSlick Scientific
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Image size:

Specify the desired size for saving images. Images are scaled (up or down) to match the selected resolution
using antialiasing.
Image format:

Select the desired image file format. Options include:
• PNG - Portable Network Graphics: An open extensible graphics format with lossless compression. This is a modern
graphics format good for emailing or including on web pages.
• PICT - Macintosh Graphics Format: The native graphics format used on the Macintosh computer since 1984. This is
available on the Macintosh version of the software only.
• TIFF - Tagged Image File Format: A file format for storing images, popular among graphic artists and the publishing
industry. This a a lossless format, but files tend to be much larger than those saved as PNG or JPEG.
• JPEG - Joint Photographic Experts Group: A commonly used method of lossy compression for digital photography.
More common than PNG with user selectable variable compression and optional EXIF data.
JPEG Options:

JPG files can be saved with a user selectable quality setting, 100% being the least amount of compression
but also resulting in the largest file size. EXIF header data is not currently supported.

Copyright © 2012-2017, MiloSlick Scientific
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Movie Preferences

Movie Files
Save Movies to:

Use the popup menu to choose a folder where movies should be saved. The menu contains some common
locations and includes an option to “Choose” a custom location. The location is automatically saved and will
be used each time you run MallinCam Control.
Filename:
• Ask: The software will display a “Save As...” dialog box each time a new movie recording is started.
• Timestamp: The filename for the saved image will automatically be determined by your system time and will be in the
format - YYYYMMDD.HH.NN.SS.jpg.
• Sequential with Custom Prefix: This option can be used to save multiple movies with the same file prefix (e.g. “Jupiter”
or “VenusTransit”) and a four digit value will be automatically appended and incremented as each movie is recorded.
Remember to include some type of delimiter (e.g. an underscore character) if your prefix ends in a numerical digit to
avoid confusion with the appended suffix. The current movie sequence value is automatically saved loaded each time
you run MallinCam Control. Click the “Reset #” button to reset this value back to zero (“0000”).

Movie Options
Setting of movie options directly from the preferences dialog is not supported on macOS Movies are
currently saved using the quality and compression settings of your video capture device. On macOS, these
settings can be adjusted in the “Video Options...” dialog box accessible in the “Video” menu.

Copyright © 2012-2017, MiloSlick Scientific
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Advanced Features
Capture Modes

There are three basic modes for capturing images: Single Snapshot, Image Sequence, and Movie capture
modes.
Single Snapshot Mode
In “Single Snapshot” mode (the default), clicking the capture button will save a snapshot of the video preview
contents, saving it as a still image to your hard driveThe saved image will include any enhancements that you
have made using the video settings controls on your hardware capture device, stacking, dark frame
subtraction, or video effects. By default they will include any graphic or text overlays that you have enabled.
Images will be saved with the filename and to the location specified on the “Photos” settings tab of the
MallinCam Control preferences dialog.
Image Sequence Mode
There may be times that it is advantageous to automatically save each new exposure - as it is completed.
Rather than having to click the “Capture” button each time, the application provides an option to
automatically record each exposure as an image sequence.

Sequence options are adjustable by clicking the “File > Capture Mode > Image Sequence Settings…” menu
item. On this dialog you can specify the number of exposures to be taken and the exposure interval (when
working in Video or SenseUp exposure modes). In “Hyper” exposure mode, the interval is determined by the
selected exposure time. Clicking the “Capture” button will cause the software to automatically save a new
still image after every new hyper mode exposure or complete image stack if this option has been enabled
(see Video Settings). Images will be saved with the filename and to the location specified on the “Photos”
settings tab of the MallinCam Control preferences dialog (see Taking Snapshots for details).
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If “Frame Stacking” has been enabled, a new image will be saved after the Nth frame has been collected,
and then for each integration afterwards. This results in a new image being saved each integration period.
Movie Mode
Movie recording only functions In “Video” and “SenseUp” exposure modes. The function of the “Capture”
toolbar button changes to allow starting and stopping of recording the live video feed to a movie file which
can be used for alignment and stacking of images in an external image processing program like RegiStax.
Clicking on the “Capture” button will create a new movie file using the location and naming convention
specified on the “Movies” settings tab of the MallinCam Control preferences dialog, and start the recording
process. The recording state status indicator shows the total time recorded in the current movie.

Image Comparison

Unprocessed and Processed images can be compared in the preview area very easily using either of the two
“Compare” buttons. The “Quick Comparison” toolbar button causes the processed image to be swapped
out for the raw unprocessed image as long as the button is held down. A “Split Window Comparison” button
will split the preview area in half showing the raw unprocessed image on the left and the processed image on
the right.
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